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RETURN OF THE SERVERS

Chris Waldrip, AMUG President

(cwaldrip@amugonline.org)

Developer’s Conference (WWDC) Steve Jobs gave a tantalizing

During the keynote speech at Apple’s annual World Wide

tease regarding Apple’s upcoming return to the server market.
The device shown on the big screen was slim and sleek, and looked
like what you’d expect from Apple - quality design. But most exciting of
all was the simple fact that it was a real server, not a modified desktop

system.

Many would argue that Apple has
been active in the server market for
several years. They have released several

RAID hard drives, eight 168pin DIMM
memory slots, and a unique case design
that still makes many Apple aficionados

of the Xserve is not out of place in a
data center; it is exactly 1U in size, or
about 1.75 inches. In datacenter par-
lance that’s 1 rack unit, or the smallest
vertical space allowed, and preferred,
in a server rack mountable device. The
Xserve’s other unique server techni-
cal features include up to 2GB of DDR
SDRAM, which is a type of high-speed
RAM found mainly in high-end PC’s;
three 66Mhz PCI slots, with two of the
slots being capable of handling 64 bit
cards; 2MB of DDR L3 cache for moving
memory contents at speeds faster than
normal Mac systems have been capable
of; dual built-in Gigabit Ethernet (aka
1000Base-T) connections; and three

reconfigured 400Mbps FireWire ports. he Xs

tower systems SO~ ST 4 T Also (f):fferfszrve
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needs of many ¥ some standard
looking to fill data center
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most system administrators turn their
noses up at previous Mac server offer-
ings, due mainly to the capabilities and
compatibilities of Apple’s offerings as
they relate to a real data center.

Apple’s last real data center style
server hardware were the Network
Servers last seen in the late 90’s. These
systems were sold for only 14 months
and used Apple’s version of IBM’s Unix
operating System, AIX instead of the
familiar Mac OS. The units sold poorly
for several reasons, among these were
the fact that the hardware was based on
the 68k processor, as opposed to the
recently released PowerPC processor,
many potential users were also turned
off by the OS, and poor marketing to
the appropriate target audiences as was
typical of Apple in the day.

Despite these problems though, the
Network Servers were unique from
anything else released by Apple before
or after. Redundant, hot-swappable
power supplies, hot-swappable SCSI

the Network servers from poor sales.
Released in February of 1997, the Net-
work Servers were pulled in April of the
following year. [For more detailed specs
on the Network Servers, look here http:
/fwww.apple-history.com/ns500.html]

Shortly after the demise of the Net-
work Servers Apple returned to their
modified-desktop-systems-as-servers line
up, the Workgroup Servers. The original
Workgroup Servers were the 60, 80, and
95 which were based on similar desktop
systems like the Centris 610. With the
passing of the Network Servers Apple
returned to modified desktops with the
release of their first PowerPC servers,
the 6150, 8150 and 9150.

But May of 2002 may go down in
Apple history as the date when Apple
finally began to make serious inroads
into corporate data centers. The Xserve
has been designed from the ground up,
like the Network Servers were, to be
a full-fledged member of a corporate
datacenter. The unique and slim design

supports headless (no monitor) boot-
ing; a DB-9 serial console port, which is
used by many data centers to connect
to various boxes for troubleshooting
and access; and up to 480GB of storage
via four hot swappable ATA/100 hard
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MEessaGe FrRoM THE PRESIDENT
Chris Waldrip, President
(cwaldrip@amugonline.org)

It’s been an interesting couple
of months thanks to Apple. Speed
bumped TiBooks (I'm still a little
grumpy about that one), speed
bumped iBooks, the eMac for educa-
tion, then the eMac for everyone.
Steve teased us with a sneak peak
at the next major release of Mac OS
X (aka Jaguar) and the Xserve. The
Xserve made its official debut shortly
afterwards. There has also been Quick-
Time 6 Preview Release, and 10.1.5
update to Mac OS X.

Why so busy? Well, the word out of
Cupertino is that Apple isn’t waiting
until one of the major events to make
announcements. If a product is ready
to ship, then they’ll announce it.
Sounds simple, doesn’t it?

The Good: Apple doesn’t have to
wait until either of the major events
(Macworld San Francisco or New
York), or even one of the second-
ary events. Waiting means that they
could get scooped by a rival company.
Throwing the spotlight on a new prod-
uct as soon as you can means you get
the spotlight first. Your product was
the innovation, everyone else’s was
the ‘rip-off’.

The Bad: I'm almost at a loss to
guess what Apple will announce at
Macworld New York. What's left? They
hired a new pilot for Steve’s jet? Okay,
so maybe they can announce upgrades
to the G4 PowerMacs, and maybe to
the flat-panel iMacs.A new consumer
device? That would make a great ‘one
more thing’ for Mr. Jobs to conclude
with. And there’s always the possibility
that Mac OS 10.2 will be ready early,
or that QuickTime 6 will finally leap
past the MPEG-4 licensing hurdles
before it.

The Ugly: What if Macworld loses

some of its luster! They keynote
speech, hosted by Mr. Jobs since his
return, has been one of the highlights
in many a Mac geek’s life. If there’s
nothing Earth shattering to be an-
nounced, then how exciting can it be?
A large part of the Steve Jobs Reality
Distortion Field is that most of what
Steve pitches really is at least neat, if
not downright cool.

I'm fairly sure that Steve could make

a potato peeler look like an amazing
advancement in computer technol-
ogy, but it wouldn’t be as amazing as

a PowerMac G5 (which for my money
we won't see until Macworld San Fran-
cisco, 2003 at the earliest).

One of these days I'd like to see a

Celebrity Deathmatch between P.T.
Barnum and Steve Jobs. My money

is that Mr. Jobs would convince Mr.
Barnum that not only had he lost but
he also needed to buy a new G4.

Well, we have a few more weeks

until the big show goes up. It'll be
interesting to see what comes of it.

Maclanta Staff
Editor-in-Chief............ccocovvneee. Chris Waldrip
Contributing Editor............. David Whitehead
Staff Photographer ................ Scott Steinbrink
Staff Photographer .............. David Whitehead

The Board of Directors
are looking for a new
Newsletter Director!

You can help oversee and
manage the production and
growth of AMUG’s monthly

newsletter.

Interested members should
write a brief synopsis stating
why they want to volunteer
for the position, what they
would bring to the position,
and what they hope to
accomplish in the position.

Please send your synopsis
to Chris Waldrip (cwaldrip
(wamugonline.org), AMUG
President, by Monday,
July 8th
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IN THE NEWS

eMacs for Everyone!

Roughly a month after Apple an-
nounced the release of the eMac for
education, Apple has changed its mind,
and we can all benefit.

The low-cost eMac, which features a
17” CRT monitor and a G4 processor,
was originally intended for the educa-
tion market where prices are best low,
and less than cutting edge features are
acceptable.

Citing a huge demand by consumers
for the eMac Apple has announced that
starting immediately the eMac will be
available through all regular consumer
retail channels. To emphasize this eMacs
were reported to be in-stock at Apple
Store locations around the country, and
other retailers were reporting shipments
due in shortly.

The base configuration is priced at
$1,099, lower than its initial Educa-
tion-only release price, and features a
700Mhz G4, 128MB RAM, 40x CD-RW
drive, and a 56k Modem. Little custom-
ization is available, with additional RAM
being the only internal modification
available.

Mac OS 10.1.5 Update Released

After a flurry of announcements Apple
quietly made the 10.1.5 update available
through Software Update.

The 22MB download offers several
updates and bug fixes. Among these are
peripheral device support (for addition-
al digital cameras and media devices),
improvements to Apple 3rd party ap-
plications (including Mail and Sherlock,
new features for Carbon applications,
and support for Rage Pro in older
Macs), improvements to networking
and security (when accessing Windows
NT servers, file searching on local and
remote drives, and generic PC Card driv-
ers), WebDAV improvements (used by
most mainly when accessing iDisk), and
better handling of Asian language.

QuickTime 6 Preview Available
Long overdue, Apple has finally begun
the process of releasing QuickTime 6 to

the masses.
MACLANTA * JUNE 2002

QuickTime 6 has been reportedly
available for several months, but a
licensing issue with the independent
MPEG-4 governing committee has held
up release. The MPEG-4 committee is
wanting to impose a 2¢/streamed hour
fee on MEPEG-4 content providing serv-
ers. Apple, and other media developers
have argued that such a licensing fee
would be prohibitive to the growth of
the format.

While there has not been a final reso-
lution to the issue, Apple seems to feel
confident that the issue will soon be put
to bed. The best example of this is the
release of the Public Beta.

The Public Beta is set to expire later
this year, and QuickTime 5 Pro and ear-
lier users must purchase a new license
to use the Pro features of QuickTime 6.
The license should be freely upgrade-
able when the final release of Quick-
Time 0 is available.

iBook Upgraded to 700Mhz

In holding to Apple’s current policy
of announcing new products when
they’re ready, upgrades to the iBook
line were announced in mid-May.

The new iBook configurations
increase the processor speed and other
aspects of their configuration.

Aside from the faster G3 processor,
the new iBooks feature a new VGA port
that also supports S-Video and compos-
ite video out with an optional adaptor.

Sticking with three configurations,
Apple now offers a 600Mhz G3 with
128MB RAM, 20GB hard drive, CD drive,
and 12.1” display iBook for $1,199. The
mid-range iBook ships with a 700Mhz
G3, 128MB RAM, 20GB hard drive,
DVD/CD-RW drive, and a 12.1” display
for $1,499. The top-of-the-line 700Mhz
iBook ships with 14.1” display, 256MB
RAM, 30GB hard drive, and a DVD/CD-
RW drive for $1,799.

Office v.X And Other MS Up-
dates announced

The first indication that Mac OS X
10.1.5 was due to be released came with
the announcement that Microsoft Office
v.X, 10.1, was available. Among the new
features in this update is support for
(the not yet released at that time) Mac
0§ X 10.1.5’s new Quartz smooth text
rendering for Carbonized applications.

The update to the popular office
package also includes a number of new
features, improvements to existing
features, and bug fixes. Among these
are support for FileMaker Server in
Excel, the return to MS Office of ODBC
support in Excel, customizable buttons,
numerous increases to stability and
performance, redesigned print system
which works natively and seamlessly
with Mac OS X.

CONTINUED ON PAGE 4

With a membership of well over 300, and with the availability of
Maclanta on the World Wide Web, there is great advertising potential.
Ad Rates

1 issue 3 issues 6 issues 12 issues

Full page $80 $160 $300
($53 per issue) ($50 per issue) ($47 per issue)
1/2 page $40 $80 $140 $250
($27/iss) ($23/iss) ($20/iss)
1/4 page $25 $50 $90 $175
($17/iss) ($15/iss) ($14/iss)
1/8 page $15 $30 $50 $90
($10/iss) ($8/iss) ($7.50/iss)
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In The News

Contivvep From PAGE 5

In addition to the latest update to the
office suite, Microsoft also announced
that their instant messaging product,
MSN Instant Messenger, has been
updated to 3.0 and is also available for
download.

Absent from the list of available
updates was the Palm OS conduit for
Entourage. The conduit, which would
allow users of Microsoft’s e-mail and
personal information manager Entou-
rage, to sync with their Palm OS devices
is due for release in mid-July.

The available updates can be down-
loaded from Microsoft’s Mactopia web
site (http://www.microsoft.com/mac/
download/default.asp?navindex=s10)

FireWire is In, IEEE 1394 is Out

Faced with increased competition by
the USB 2.0 format (thanks in part by its
developer Intel including the standard
on its latest line of motherboards),
the FireWire standards committee has
agreed to adopt Apple’s trademarked
name “FireWire”, and a modified
version of Apple’s FireWire logo (the
addition of IEEE 1394 under the logo),
as the official name and logo for the
standard.

Apple offered to freely license the
trademarked name and logo free to
developers and manufacturers looking
to use the technology in their products.

Sony, the next largest manufacturer
using FireWire has announced that
it will stay with its trademarked iLink
name and logo. While not bound or ob-
ligated to use FireWire, Sony feels that
the version of the IEEE 1394 standard,
un-powered two lead connector as op-
posed to the more common powered
four lead connector, will continue to
benefit from the iLink name.

Aspyr Pumps Out The Games
Over the last month, and probably
due in part to the E3 computer gam-
ing trade show in California, Aspyr has
announced the release, or the pending
release, of several games for the Mac.
One of the first titles announced
during this wave was Return to Castle
Wolfenstein. The ID game, based on the
classic Wolfenstein game from the late
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80’s, is a first person shooter when you
play a US secret agent in Nazi Germany.
You must escape from Castle Wolfen-
stein, and then return to investigate a
mysterious plot involving cybernetics
and the occult.

Also set during World War II is Medal
of Honor: Allied Assault. This follow-up
to the popular PC game places you in a
first person perspective on the beaches
of France. Your job, to survive and push
into the heart of Europe to free it from
the clutches of the evil Nazis. Exciting,
and realistic, missions combine with
great graphics.

Two Star Wars related titles are head-
ing for Mac gaming shelves as well. Jedi
Knight II: Jedi Outcast is a first-person
shooter (with optional above and be-
hind perspective) where you play a ren-
egade Jedi turned mercenary who must
hunt down the leaders of the remnants
of the Empire and avenge the death of
your partner. The game features excit-
ing light sabre action, unique use of The
Force, and a number of puzzles, all in
a fascinatingly rendered game environ-
ment.

For live-action strategy enthusiasts,
and fans of games like Command and
Conquer, Star Wars Galactic Battle-
gounds will get your attention. You
have to acquire resources, manage unit
construction, and stratigize defensive
and offensive actions against your
enemies.

In the horror vein there is the release
of Clive Barker’s Undying. The famous
horror novelist has led his gruesome
writing talents (and voice) to this
game based on the Unreal and Unreal
Tournament software engine. Based
in Ireland, you

expansion to the popular Sims universe.
Now you can take your Sims out of their
house, and downtown to popular hang-
outs for single Sims. Meet, and get to
know other Sims, and eventually setup
your Sim on dates and other interesting
aspects of relationships.

TiBook CD-RW/DVD Upgrade

Owners of the original Titanium Pow-
erBooks, and even early owners of the
next update to the TiBook line, were
upset when Apple released CD-RW/DVD
combo drives in new TiBooks.

To appease early adopters of the sec-
ond generation TiBook who missed out
on the option, Apple offered an upgrade
plan. Owners could pay a few hundred
dollars to have their DVD drive replaced
with a CD-RW/DVD drive either at an
Apple Store or by shipping their laptop
to Apple’s PowerBook service group.

First generation TiBook owners were
left out though.

MCE to rescue! MCE, known for their
PowerBook expansion bays and Power-
Book peripherals, is offering owners of
the original TiBook an upgrade option.
For $300 owners can ship their Power-
Book to MCE, or bring it into an MCE
authorized service shop, and have a
slot loading CD-RW/DVD combo drive
installed.

The drive is bootable and works in
both Mac OS X and earlier. Users can
expect 8x record times, and 24x read
times with CD, CD-R, and CD-RW discs.
DVDs are read at 8x.

The drives work with Apple’s iTunes,
Discburner, and DVD player. And Dantz
has certified the drives as compatible
with Retrospect.

play a detective in
this first-person
shooter. You must
battle the undead
siblings of an old
castle’s remain-
ing inhabitant to
defeat an evil plot.
For the less
violent among us
there is the latest
update to The
Sims. The Sims:
Hot Date is a new

- workflow solutions - design consulting

info:/gratix

Discounts for AtlantaMUG members!
See our listing at atlmug.org
or 90 to www.infografiy.net/atlmug.html
1743 Taynton Circle * Kennesaw GA 30152

ph 678.290.1954 * fax 678.223.2000 x 1746
sales@infografix.net * www.infografix.net

JUNE 2002 *« MACLANTA


http://www.microsoft.com/mac/download/default.asp?navindex=s10
http://www.microsoft.com/mac/download/default.asp?navindex=s10

GRAMMARIAN 2 & SPELLCATCHER 8

By Howard Davis, AMUG Member
(howarddavis3 @earthlink.net)

Did you know that “irregardless” is not a word? Just a few years ago, I didn’t. It
sure seemed (Whoops, surely seemed) like a word to me. And then one day,
I learned that there is a difference between the words ‘then’ and ‘than.’ I suppose
that in the back of my mind I knew that. The difference, however, just didn’t regis-
ter. When I finally found out, I wondered what other grammatical errors I was mak-
ing. Perhaps I was blithely making errors equivalent to “I seen him when he done
it.” So when the Grammarian 2/Grammarian X software was offered in exchange for
a review at a recent AMUG meeting, I jumped at the chance. Then, just a few days
later, I won Spell Catcher 8 at AMUG’s Mac University. It’s Grammarian’s compan-

ion, so I'll throw that one in as well.

Both programs installed easily. Each
adds a check mark between the time
and the open applications menu in the
menu bar (I'm still using system 9).
Though both run in the background,
only Spell Catcher shows up as an open
application.

its dictionary. If you were to add the
word to the spelling dictionary of most
programs, it would only help for that
one program. Since Spell Catcher 8
works with all programs, you can just
add it once and it will be available in all
your programs. Simi-

Both applica- )
tions can be used to
check your writing
as you type, or they
can check it after
you complete it. If
you leave on the
interactive checking,
then you will hear :
a little beep when
you make a mistake.
I don’t usually pay
too much atten-
tion to that and just
wait to batch check
everything. How-
ever, Spell Catcher
8 will auto-correct

larly, in Grammarian,
there are some rules
that it will invoke
that you may decide
+' | you don’t want to be
bothered by (‘yea,

- I know it’s a collo-

4 -/ | quial expression, so
what?). You can have
Grammarian ignore
that error either for
all programs, or,
perhaps, for just
your e-mail program.
Grammarian also
can check in many
different styles and
these can be set for

L5l

the spelling on some
commonly misspelled words. That is
pretty neat and is probably the best
reason to leave the interactive checking
on. So why don’t I pay attention to the
beeps? Well, that brings up the basic
problem with any writing tool. They
just aren’t that smart yet. Yes, these
programs are pretty good and do catch
many errors. But, though they are very
helpful, both are far from perfect. This,
however, is not a reason to forgo using
these programs and just continue using
the spelling/grammar checkers that
come with many programs. Rather, it is
one of the strongest reasons for getting
the two programs. For instance, most of
the words which Spell Catcher 8 incor-
rectly flags are proper names or terms
which one may often use, but aren’t in
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different programs.

Besides the basics, both programs
have additional features. Grammarian
can give statistics for a selected section
of number of words, average number
of words per sentence, average number
of syllables per word, percentage of
passive words, and general readability.
These can help in making your writing
more interesting. Spell Catcher has both
a thesaurus and a dictionary. I've found
both useful.

I've been using these programs now
for over a month, and I've really been
pleased with both of them. Did Gram-
marian find any grammatical errors
that I was making over and over? Well,
nothing too major. However, it has
complained on numerous occasions
that some phrase of mine is “wordy.”

Often I'll rewrite the sentence, but
sometimes I like it just the way it is. And
then, sometimes I am not too sure that
Grammarian is correct about all the er-
rors it flags. Usually, it will offer at least
one or two corrections that just don’t
seem right to me. I may think about
them, but in the end, I just ignore them.
So, though Grammarian 2 and Spell
Catcher 8 have become essentials in my
writing process, I don’t rely on them
completely. I use them both on most of
my writing just before I apply the proce-
dure I still believe is most important for
improving one’s writing. I read through
it again from beginning to end before I
click on print or send.
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Title: Grammarian 2/X

Web Site: http://shop.casadyg.com/
?page =shop/browse

Publisher: Casady & Greene

Requirement: System 8.1-9.x, Mac OS X
10.x, CD Drive

Reviewer’s Rating: 4 Peaches

Title: SpellCatcher 8

Publisher: Casady & Greene

Web Site: http://shop.casadyg.com/
?page=shop/browse

Requirement: System 8.1-9.x, CD Drive

Reviewer’s Rating: 4 Peaches

Want to review your favorite soft-
ware or hardware? Send it in to

maclanta@amugonline.org!
PAGE 5


mailto:howarddavis3@earthlink.net
http://shop.casadyg.com/?page=shop/browse
http://shop.casadyg.com/?page=shop/browse
http://shop.casadyg.com/?page=shop/browse
http://shop.casadyg.com/?page=shop/browse
mailto:maclanta@amugonline.org

Xserve Announced

Contivuep From Pace 1
drives. These three features alone set
the Xserve beyond Apple’s typical server
offerings in the past. Combined with the
additional features mentioned above,
and some of the optional offerings for
the Xserve, many feel that this latest of-
fering from Apple is a serious contender
for space in corporate data centers.
Apple also has plans to release an
external storage device. This RAID stor-
age add-on to the Xserve will connect
via a dual 2GB fibre channels which will
offer extreme storage access

1Ghz PowerPC processors in the Xserve.
The use of up to four IDE drives helps
as well as data can be written almost
four times as fast as it could with a
single IDE drive. But for users needing
more drive access speed there is always
Apple’s forthcoming RAID drive enclo-
sure. And an Ultra3 SCSI 64-bit PCI card
is also available.

Other data center administrator issues
concern things like the lack of hot-swap-
pable power supplies in the Xserve itself
and the use of the Mac OS X operating
system. Administrators are use to swap-

While the choice of using the Mac OS
X OS and GUI may aggrivate some who
believe that it’s a waste of a server’s
valuable processor time, Apple has
included a unique monitoring package,
Server Monitor. With this application ad-
ministrators will be able to see the sta-
tus of hundreds of Xservers and various
aspects of their operation. Everything
from system temperature, fan status,
hard drive health, ethernet status, and
the health of power supplies. All from
one interface.

Since its introduction a few weeks
ago, Apple’s Xserve has re-

capabilities and capacities.
The external storage device
will be capable of contain-
ing up to fourteen drives,
with up to seven on one
of two RAID controllers.
Redundant power, cooling,
and drive capability will be \
standard. Up to 1.68TB, or
1,680GB, of storage will be
accessible with 400MB /sec
data throughput.

But there are still some
old school data center ad-

A iy
ministrators who have res- [ [#8
ervations about the Xserve. —

Many of their concerns

are mainly over unproven
issues. The use of ATA/100,
while a faster version of the

A&g{le’s Network Server
500 & 700 (above) was a

Then and Now

IDE drives found in most
Mac desktops today, is alien
in most servers used today.
SCSI, oddly enough the old
standard for hard drives

revolutionary product for
Apple, but never caught on.

The rack of multiple
Xservers éright) is light
years ahead in power and

in desktop Macs, and a
much faster and expensive
technology, is the main-
stream standard in data

performance.

ceived critical acclaim, and
some harsh criticism. While
it would be unrealistic to
believe that Apple would
cause the manufacturers of
high-end server equipment
(Compag/HP, IBM, Sun) to
look over their shoulder,
these same manufacturers
also produce low-end and
mid-range server equip-
ment - area’s where Apple’s
Xserve may pose a threat.
During the release an-
nouncement Apple them-
selves indicated that the
Xserve is being targeted
at Mac heavy installations.
Customers that already
use Macs throughout their
company, and would like to
continue that trend in their
data centers. Sites heavy in
graphic design, web design
and development, soft-
ware developers, and even
educational institutions
are all expected to be early
adopters of the Xserve.

Photos Courtesy of Apple Computer

centers. And Apple’s use of
software RAID would seem
to limit the capabilities of the hard drive
array. Software RAID is typically slower
than hardware RAID controllers. As for
network connections, while the Xserve
has two built-in RJ-45 Gigabit ethernet
connections, fiber Gigabit ethernet is
more common in data centers where
such speeds are needed.

Supporters of the Xserve point out
that IDE hard drives are much less
expensive than equivalently sized SCSI
drives, and that the use of IDE drives
and Software RAID shouldn’t pose too

much of a drain on the single or dual
PAGE 6

ping one of at least two power supplies
in most servers, without the need to
turn the unit off. The Xserve doesn’t
seem to offer this feature. And most
data centers use one of three operating
systems made by Microsoft, Sun, or one
of the various flavors of Unix. Mac OS
X has, at its core, BSD Unix which most
system administrators would find famil-
iar and easily accessible via the terminal
application, through the option to start
up the Xserve in command line mode,
or to simply access the Xserve through
the DB-9 serial port and a terminal
display/keyboard.

And recent announcements
from developers like Oracle, Adobe,
Dantz, and FileMaker that they will

be supporting the Xserve with future
releases of their software will help the
future of the Xserve. Even Hewlett-Pack-
ard has announced that its OpenView
management software will be supported
on the Xserve.

While anything is possible, it would
seem that Apple has learned from the
mistakes of the Network Servers. The
Xserve would seem to have great po-
tential, and may even be a precursor of
bigger things to come.
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AMUG ONLINE Tips ANDp TRricKS

Sheryl McDonald, Online Comm. Sysop
(sheryl_mcdonald(@amugonline.org)

Creating a FirstClass R sum

Creatingar sum is quite simple. It
does not take a special form.

Now by r sum we do not mean the
one you would submit to obtain a job.
The one you create here is meant to
quickly identify you to other members,
so that they can, just by clicking on your
name in a message header, see a brief
description of your background, occupa-
tion, experience with computers, etc.

This really comes in handy when you
try to send mail to someone else you
briefly met at one of our meetings, and
all you can remember is the first name.
The FirstClass client will let you see a
list of everyone on AMUG Online with
that first name, and by clicking on each
one you should be able to figure out the
correct person to address your mail to.
Some folks even add their pictures to
the r sum which makes it a lot easier to
figure out who is who.

For a sample of what some folks have
entered in their r sum , double click on
the names in postings in the conference
folders.

As a means of encouragement to take
a few minutes to fill one out, we reward
those that do with more time on the
system. I hope your next question is.....

Q: SohowdolIcreatear sum ?

A: It depends on the client being

used. Here is our guide.

HOW TO ENTER YOURR SUM

If you are logged on using a regular
text based communication program then
ty;l)e RESUME to enter your r sum , and
follow the instructions or...

If you are logged on via a web browser
you will have to log back on via a regular
FirstClass client.

If you are logged on using the First-
Class client, then with the 5.5 Client or
later, under the File menu, select Open,
R sum (cmd-5 is the keyboard shortcut).

With earlier versions of the FirstClass
client, look under the Edit menu, select
R sum , or anywhere you see your name,
like in a post to you, just double click on
your name.

With the FirstClass client you will see
a form with three parts: above the line
and to the left a small box where you can
paste in a graphic (.pict), a longer box
to the right where you can type in your
name, and below the line, a place to type
inyourr sum .

MACLANTA ¢ JUNE 2002

Step 1.
In the top right box enter your name

(we may have already done that for you,
make any changes you wish).
Step 2.
Tab down to the lower box and enter
yourr sum .
The purpose of the r sum is to
quickly identify you to someone else.
It should be short and sweet. What you
type in is up to you, but we would like it
to be the type of information you would
feel comfortable sharing with a member
of the group whom you don’t know yet.
Just as if you were introducing yourself
to someone at a meeting.
Please consider letting others know:
* what type of computers you use
* what software/hardware you use,
and if you are willing to help others
with same
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A peek at a FirstClass r sum . You can paste
almost any image in your r sum , or a picture
of yourself.

* what modem you use

i Kour occupation

* hobbies and other interests

* plus a simple visual description of
yourself, so if I remember you from
a meeting as being tall, blond and
clean shaven, I don’t send a post
to someone short, brown of hair.
(Note: you can include a photo of
yourself)

* but nothing too personal like a
home phone number or address.
Remember, r sum s can be read by
anyone accessing the system, by just
double clicking on your name. You
can include phone numbers if you
wish, but you don’t have to.

Step 3. (Optional)
If you are using the FirstClass Client
you can cut and paste a Pict photo of

yourself in the upper left box on the
form.

Step 4.

Closing the box enters your r sum .
You do not need to do a send.

You can update your R sum informa-
tion at any time. I have found that you
can not delete the photo, but you can
always replace it. You can edit any of the
typed information.

Now that was simple, wasn't it?

Okay, so maybe it wasn’t. Here is what
Centrinty has to say on the matter in the
online Help conference. ..

About r sum s

FirstClass provides every user with a
r sum , which is a special form designed
to contain personal information. Other
users can open this form if they want to
see information about you. Your r sum
is blank until you update it.

In addition, conferences and calendars
can have r sum s to provide information
about them.

Updating your r sum

To add personal information to your
r sum :

1 Choose File > Open > R sum .

2 Type your name in the top input

area.

3 Paste your picture from the clipboard
into the top left corner, if desired.

4 Type any information that you think
would be useful to other users in the
bottom input area. For ideas about
what to write, look at other users’

r sum s.
5 Close the r sum .
Your changes are saved automatically.

Viewing others’ r sum s
To view another user’s, a conference’s,
or a calendar’s r sum :
1 Select the appropriate name in:
* the Directory
* 2 Who's Online list
* the “To”, “CC”, or “BCC” fields of a
message
* the “Participants” list in a chat
window
* a message or calendar event his-
tory.
2 Choose File > Open > R sum . Or
you can double-click the name.

Read more tips and tricks for FirstClass
in the BBS QGA forum on AMUG’s online
community. If you have questions or tips

of your own contact Sheryl McDonald

(sheryl_mcdonald@amugonline.org).
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AMUG NEews

JUNE MEETING SUMMARY

At the May General Meeting, AMUG
was fortunate to have Macworld colum-
nist Andy Thnatko present his views on
technology, life and the future direction

of the Macintosh.

Due to the larger than normally ex-
pected audience, the meeting itself was

moved to the auditorium at
Unfortunately, this move
seemed to have an adverse
effect on the total AMUG
members attending as we
were missing the regulars.
Regardless, many new faces
were spotted along with a
number of non-members
and a good crowd was on
hand to hear Andy’s talk.

A succinct summary will
be impossible to provide as
Andy covered a great deal
of ground in his discus-
sion. From elaborating on
his ber-geek house (wired
with microphones so he
can instruct his computer
to read online news to him
as he’s lying on the couch,
among other things) to cov-
ering what institutes good
marketing to making cool
hats to his latest project
making a DVD on Mac OS X
to where he thought Apple

Computer was heading with

the introduction of Jaguar
(the code-name for the next
version of Mac OS X).

After the presentation,
Andy entertained questions
from the audience and fur-

ther elaborated on the direction being

light of the fact that Apple introduced
their new Xserve server the day of the
General Meeting (Andy liked it).

At the conclusion of the meeting, a
Macquarium, signed by Andy Ihnatko,
was given away to Jaddie Dodd in the
meeting raffle. Congratulations Jaddie!

St. Joseph's. Varsity for dinner after the meeting.

taken by Apple Computer, especially in

And to send Andy off with a true taste
of Atlanta, he was taken to the venerable

AMUG President, Chris Waldrip, presenting Andy Ihnatko with an AMUG polo shirt, a six-pack
of bottled Coca-Cola, a Braves baseball cap, and some CNN souvenirs.

Andy and some AMUG members enjoying the fine dining at The Varsity. (Pictured from left to
right: Robert Cameron, Michael Henigan, Charlie Newton, Paul Quinnell, David Whitehead,
Chris Waldrip, Brian Mackey, and Andy Ihnatko)

May Raffle Winners
Jaddie Dodd .........covieiriiii Autographed Macaquarium
Apple “Been There, Done That” T-shift...........ccccooeerrrieeniennnnen Mark Shefrin
Apple longsleve T-Shirt ............cccooverivierniierieeeeee e, Harmen Steele
Apple longsleve T-Shirt ............ccocoieeriieriieeieeeeeeiee, Lawrence Sharp
Apple G4 Cube T-SHirt ........ccoevveieiriiiiiirieeeeeee s Bruce Barett
GLrAMALIAN X....coviiieeiieice e Will Hawkins
Gramarian X......ooouvvveviueriinieiieieieeeses e e Patricia Schiffman
Lenox Apple Store T-Shift ..........cooeveeriiveiriieieiieeieieeeceissienas Bruce Barett
Apple Professional MUG ............cccoveeuriieiriineinieeeieeeieeiee i, John Trent
AppleWorks 6 & Missing Manual ...............ccoovererrierrienenerennns Topher Kohan
Mac OS X 10.1 & Missing Manual .............cccccoueireriieiniiieninnne. Howard Davis
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JunE BOARD OF DIRECTORS

MEETING SUMMARY

This month’s meeting of the Board
of Directors began with the current
reports from the officers and directors.
Of particular note was the summation
of the first Telecomm Board meeting.
Discussion mainly covered how to better
integrate the online community with the
web site, and reaction to a report that a
member sent an unsolicited e-mail to a
large number of people. The member
has apologized, and the member of the
community who reported the incident
has received a written apology from
Todd Johnson, Telecomm Director.

Stan Allen, Education Director,
reported that the special interest groups
(SIGs) are doing well, and discussion was
had regarding two additional SIGs - the
Internet SIG and a Gaming SIG. More in-
formation on these will be forthcoming,

Chris Waldrip, President, handed a
check for $1000 to Kelly Hilliard. The
funds were donated to AMUG by a large,
local corporation that wished to remain
anonymous. The funds will go towards
helping AMUG in our efforts to recycle
old Mac’s for local non-profit organiza-
tions.

With the conclusion of the monthly
reports, and a short break, a few items of
business were discussed. The filing of the
Newsletter vacancy was covered, with the
board deciding that while one qualified
candidate has come forward, we should
heavily publicize the vacancy and make a
decision at the next meeting.

The contents of a Membership CD was
debated. The CD will contain informa-
tion and programs that new and current
members will find of interest. The first
CD’s should be completed before the
end of the month.

Related to the Telecomm Committee’s
meeting, the Board discussed better ways
to integrate the online community with
the web site. Look for some interesting
things in the near future.

The topic of possibly revising the
AMUG logo was raised. It was decided
that David Whitehead, Publicity Director,
who had developed some candidates,
would contact some of our more artistic
members and solicit their concepts for
a new logo. The board will present po-
tential candidates, including the current
logo, to the membership at a future date
for final approval.

The meeting adjourned shortly after
10 p.m.
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NexT MEETING: JUNE 18T1H, 2002

Doug Franks, Program Director
(doug_franks@amugonline.org)

So you want to work all day at home in your pajamas!

The June 18th General meeting on Macromedia Drem-
weaver is a must for you to attend. The meeting will be
held at Macquarium and begins with a technical Q&A at
7 PM. The Macromedia presentation will begin at 7:30

PM.

The Atlanta Macintosh Users Group is proud to present
Macromedia Dremweaver MX web site design tool. The
presenters of this industry standard software will be Ka-
tie Black, Chris Waldrip, Jay Cann, and other web savvy
AMUG members. The presentation will consist of:

* What is web page design all about
* Where does Deamweaver fit in
* Demos of how Deamweaver works in OS 9 and

OSX

* What are the new features that are helpful in the

latest

* Deamweaver MX release?

* Where you can take FREE classes to learn
Dreamweaver! Is it still free if the state of
Georgia buys your books also?

We look forward to seeing you there.

g
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(Pajamas are optional)

June BupGer REPORT
May Balance (5/1/02)...... $8199.46

Income Sub-Total............. $374.14
Expenses:
Andy Thnatko Visit............. $262.69
Telephone..........cccovvuuee. $225.96
Printing.........ccocoecevveennnnes $133.31
Expenses Sub-Total .......... $827.46

June Balance (6/2/02) ..... $7746.14

Thanks for
joining AMUG:
Chintan Amin, Homer Bartlett, John
Dulion, Pail Hale, Scott Karlins,

Sandra Mayo, Jacki Rudd, David
Terrasco, and Robert Williams

And for renewing

your membership:
Shari Coxford, John Dulion, Jerry
Etheridge, Kathy Grawe, Mike
Henigan, Barbara Jackson, Don
Larson, Larry Miller, Jacki Rudd, Allen
Walters, and Caroline Widmer

AMUG
MEETING SCHEDULE

General Meetings
(Usually on the 3rd Tuesday of the month)

1/15/02  Apple; Jack Quattlebaum,

speaker

219/02  Home networking (file
sharing/DSL/Cable/
wireless)

3/19/02  FileMaker

3/23/02 Maclanta Xpo 2.0

4/16/02  Hooking Into the
Digital Hub

5/14/02  Andy Thnatko

6/18/02 Macromedia

7/16/02  PDAs

8/20/02  Apple Computer Macworld
update

9/17/02  Genealogy

9/28/02  Maclanta Xpo 2.5

10/15/02 Buying & selling online
(eBay and other sites)

11/19/02 Cool gadgets and games
for your Mac

12/17/02 Holiday party and iTools
(how to make a home

page)

Board of Directors Meetings
(Usually on the 1st Wednesday of the month)

1/2/02 7/3/02
2/6/02 8/7/02
3/6/02 9/4/02
4/3/02 10/2/02
5/1/02 11/6/02
6/5/02 12/4/02

Note: Remember, all dates and topics
are subject to change. Please check
the web site and online community
for updates. All general meetings,
except for the Maclanta Xpo, are

at Macquarium, and all board
meetings are held at Saint Joseph’s
Hospital’s Education Center, unless
otherwise noted.

MACLANTA ¢ JUNE 2002
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JUNE EDUCATIONAL ACTIVITIES

NEw MEMBER ORIENTATION

Announcing the first New Member
Orientation held before the start of
regular AMUG Monthly General Meeting
at Macquarium on Tuesday, June 18th,
starting at 6 pm.

This is an informal get-together where
new members can get information and
instruction on all that AMUG has to
offer!

The new member orientation is from
6 pm - 7 pm in the Macquarium Board
Room with the General Meeting follow-
ing immediately afterwards downstairs.

Please RSVP the Membership director,
Mike Henigan by e-mail (michael heni-
gan(@ amugonline.org) or call the
AMUG membership line at 404-327-9002.

Directions to Macquarium can be
found in the events folder in the AMUG
Online Community or at the AMUG web
site http:/www.amugonline.org.

Basic Systems TRAINING

Crass

The next Basic Systems Training Class
is being held on Saturday, June 15th at
New Horizons Computer Learning Cen-
ter. The class begins at 10:00 A.M. and
continues until 1:00 P.M. AMUG veteran
Jaddie Dodd is your instructor and will
cover one of a series of three topics at
each class.

The June class will cover the Internet.
Registration is required. Please RSVP to
Jaddie Dodd (jaddie(@jaddie.com)

Directions to New Horizons can be
found in the events folder in the Online
Community or on the AMUG web site
http://www.amugonline.org

¢ OS X SIG

The next meeting of the Mac OS X
Special Interest Group will be held on
June 11th in the Education Center at St.
Joseph’s Hospital from 7 pm - 9 pm.

The Mac OS X SIG is co-hosted by
Unix and Mac Guru Jay Cann and AMUG
President Chris Waldrip. Meetings are
regularly on the second Tuesday of
each month, from 7 pm - 9 pm at either
Macquarium or St. Joseph’s, depending
on the expected attendance. Directions
to Macquarium and St. Joseph’s can be
found in the events folder in the AMUG
Online Community or at the AMUG web
PAGE 10

site http://www.amugonline.org.

The topic for this month’s meeting
will be “Jaguar: A Tour Of The Fu-
ture” and will feature a tour of Apple’s
next version of Mac OS X - code named
Jaguar.

With it’s release to developers in May
at the World Wide Developer’s Confer-
ence, Apple’s Jaguar looks to be closer
to release than ever. While the build
that developers received to play with is
still very beta, several exciting enhance-
ments and features look to be coming
down the pipe.

Join us this June as we take a quick
guided tour though some of these
enhancements and new features. But be
warned - this is a beta, and not the final
product. Anything and everything could
change between now and ‘late Summer’
when Apple releases the next major ver-
sion of Mac OS X.

Please R.S.V.P. via e-mail to Co-chair
Chris Waldrip at (cwaldrip@amugonli
ne.org).

Murtivepia SIG

News from the Multimedia Special In-
terest Group! Back by popular demand,
the Multimedia SIG is resuming its
schedule of monthly meetings. The SIG

will cover a wide range of topics, includ-

ing producing digital video, audio, 3-D
and interactive content and is co-hosted
by William Moss & Stan Allen

This will be YOUR SIG, so give us
your input on the direction of the
group.

Our regular meetings will be the
Fourth Monday of the Month. The
next MULTIMEDIA SIG Meeting will be
Tuesday, June 25th, from 7 pm - 9 pm
in Classroom 5 of the Education Center
at Saint Joseph’s Hospital.

Directions can be found in the events
conference in the AMUG online com-
munity or on the AMUG Web site http:
/fwww.amugonline.org

The topic for the June meeting will
be getting started with Final Cut Pro!
Please R.S.V.P. by e-mail to William Moss
iwilliam_moss@amugonline.org)

NTERNET SIG

Announcing The newest AMUG SIG,
The Internet SIG! Hosted by Brian
Mackey.

Brian will be heading up the just re-
established Internet SIG. It will be cov-
ering all topics related to the internet,
including web design and publishing.

A meeting schedule is now in de-
velopment. If you want to join the
group or have questions, please
get in touch with Brian at (brian_
mackey(@amugonline.org)

GaminG SIG

Wanted: Mac Gamers looking to get
together on a regular basis to play net-
workable games.

Michael Henigan, Membership
Director, is currently developing this
SIG. Members interested in having
input into the creation of this SIG
should contact Michael (michael
henigan(@amugonline.org) with sug-

estions, questions, and input.

ISCLAIMER

It is important that you check the
AMUG Online Community and the
AMUG Web Site for the latest details on
all meetings, as the content and location
of these meetings are subject to change
without notice. Comments and recom-
mendations should be addressed to Stan
Allen (stan_allen(@amugonline.org),
Education Director.

6/11/02 Mac OS X SIG

6/15/02 Basic Systems Training
(The Internet)

6/24/02 Multimedia SIG

7/9/02  Mac OS X SIG
7/20/02 Basic Systems Training

(Basic T-shooting and Maint.)
7/22/02 Multimedia SIG

SPECIAL INTEREST GROUPS SCHEDULE

8/13/02 Mac OS X SIG

8/17/02 Basic Systems Training
(Basic Use of Mac OS)

8/26/02 Multimedia SIG

9/10/02 Mac OS X SIG

9/21/02 Basic Systems Training
(The Internet)

9/23/02 Multimedia SIG
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RETURN TO CASTLE WOLFENSTEIN

By David Whitehead, Publicity Director
(david_whitehead@amugonline.org)

h, the nostalgia. Many a study hall was wasted in the computer lab defending

he world from the Nazi menace in the original Wolfenstein on the Apple |[.
Playing an agent of the Allied forces, you began in the bowels of the notorious Nazi
castle and had to fight your way out, facing guards, SS agents and even Hitler him-
self. And now, nearly 15 years later Aspyr has afforded that opportunity yet again
with their first person shooter, Return to Castle Wolfenstein.

Based on the Quake III engine, RTCW  crackle, and shell casings hit the floor
is a great tribute and wonderful exten-  with a resounding ‘ping’. A good set of
sion of the original game, and offers speakers is a must for this game as many
two different methods of play. In the clues will be provided aurally (and will
single player mode, you again play an help save your bacon in many regards!).
agent of the Allied Command (working I recommend learning to identify the
for the Office of Secret Actions) and
your mission is to discover what the
Nazis are doing hopping around the
globe getting involved in everything
from bio-engineering to the occult.
In the multi-player, you select one of
five different character types working
either for the Axis or Allied forces.
This review will focus on the single
player component.

And what’s
an FPS game
without
weapons? As
the game is
set during
WWIL RTCW
stay (mostly)
true to the
weaponry
used in that
era includ-
ing MP40s,
Steins,
Thompson
machine guns, and .45s. More
esoteric weapons (which are a
lot of fun) include a flamethrow-
er, a missile launcher, a Venom
(you have to see it to believe it)
and a number of scoped rifles
for sniper activity. Each weapon
requires a different tactic to be
used effectively, with certain
weapons being quieter than
others making them useful for
stealthy operations.

The environments (there are six total
missions) are wonderfully rendered
and confirm that great attention was
given to creating a realistic environment
(more on sound later) with minute
details. Flags flap in the breeze, fires
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various grenade sounds as they come
clanging toward you.

There are a variety of enemies to face
in RTCW, ranging from multiple types
of Nazi soldiers to undead horrors such
as zombies and mummies. And with the
artificial intelligence used by the game,

enemies can be quite fierce and clever
and react differently depending on the
situation. Enemies facing you alone may
retreat and wait for reinforcements to
arrive before taking you on, or they may
try to attack you from a different flank
while waiting for the reinforcements.
Getting through this game certainly was
a challenge!

While the system requirements are a
bit steep, I was able to play RTCW very
easily on my upgraded G4/450 (it was
originally a G3/300) with no major er-
rors or slowdowns encountered.

As I don’t normally enjoy FPS as they
rarely require any more talent than fast
twitch muscle ability, I viewed RTCW
| with some skepticism. But after play-
ing through this challenging game I
thoroughly enjoyed myself. Word of
Warning to the Parents: while this
game keeps the blood and gore to a
minimum there are some dramatic
acts of violence (body parts, zombies
eating corpses) that make this game
too dark for the kids. But if you're
looking to escape into the past,
RTCW is a good way to get there.

Publisher: Aspyr Media

Web Site: http://www.aspyr.com/
mini-sites/rtcw/

Requirement: Mac 0S 9.2/10.1, Power
PC G3 500 MHz, 128 MB RAM, 660 MB
HD space

Test machine: Mac OS X 10.1.4, Power
PC G4 450, 768 MB RAM, Radeon: Mac
Edition (32 MB)

Reviewer’s Rating: 4 Peaches

Want to review your favorite soft-
ware or hardware? Send it in to
maclanta@amugonline.org!
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Your Ad Here!

1/8 page ad, $15 for 1 issue,
$90 for 12 issues
(That’s $7.50 per issue!)

Contact maclanta(@amugonline.org

Your Ad Here!

1/8 page ad, $15 for 1 issue,
$90 for 12 issues
(That’s $7.50 per issue!)

Contact maclanta(@amugonline.org

USED MACS
MAC

OF ALL
TRADES
.C QM

404.355.5144

Sell your G3/G4 or check pricing

ONLINE

sales@macofalltrades.com

INTELLIGENT

MACZ= UARIUM
=</

COMMUNICATIONS

CREATIVE

BOLD

INTELLIGENT

Steadfast in our dedication to bring
tomorrow's technology into the present

www.macquarium.com

1800 Peachtree St, NW « Suite 250 « Atlanta, GA 30309 » 404.554.4000
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TrrantuM BoOKENDZ
By Chris Waldrip
(cwaldrip(@amugonline.org)

In my office setting I see dozens of laptops from Dell, HP, IBM, Gateway, and

others. Almost all of them have a docking station from the manufacturer that

allows the users to plug their laptop in and instantly have their USB, printer, video,
serial, and other connections hooked up. Most of these use an extra connector that
provides all of these connections in one port. The notable exception to the list of

manufacturers is Apple.

The last Mac laptop to feature a
docking port was the Duo line. You
could argue that the Duo’s completely
defined the docking station metaphor
for laptops. The original Duo Dock’s
looked like standard sized desktop sys-
tems, with a large slot in the front. You
would just slide your Duo right in, and
everything would hook right up. The
full sized Duo Dock even had an extra
hard drive, since portable drives were
prohibitively expensive.

But with the demise of the Duo
Apple has left PowerBook users dock-
ing station-less. Our only recourse has
been third party products, mainly from
BookEndz.

While the BookEndz name has passed
from company to company, most
recently from NewerTech
to Photo Control Cor-
poration, the product
has remained basically the
same. With the lack of a single
docking port on Apple’s line of porta-
bles, the BookEndz are required to align
perfectly with the various connectors
on the back of the PowerBook. In the
case of the recent model of Titanium
PowerBooks the list of ports are: power
connector, one FireWire port, one RJ-
45 Ethernet port, two USB ports, VGA
connector, an S-Video out port, a reset
button, and an RJ-11 modem port.

All those ports can make it somewhat
troublesome to connect your Power-
Book, but there’s not much of a way
around it. In my particular case, with a
Titanium PowerBook, I had to remove
the S-Video port. This connector looks
similar to an ADB connector, and I find
it hard to believe that other users don’t
have similar problems with the port. To
remove the S-Video from the dock I re-
moved about eight Torx screws from the
bottom of the dock and took the lid off
the docking portion of the BookEndz.

In previous models of BookEndz the
ports were just pass-through connec-
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tors, with little else in the dock. With
the new Titanium BookEndz, the ports
that the PowerBook connects too plug
into a circuit board, and the connec-
tions on the back of the BookEndz are
attached directly to that circuit board.
I assume that this makes modifications
to the BookEndz with the

release of fu-
ture models
a bit easier.
In my case

I just un-
plugged
the
S-Video
port
from

the cir-
cuit board and
put it to the side.

In my daily use I rarely, if ever, need
S-Video out at work. If I did I guess I
would look harder and trying to make
the port dock easier with its counterpart
on my TiBook. If you do need S-Video
out from your TiBook though, the
BookEndz has a special treat. The Book-
Endz basically breaks out video from
your S-Video port to both an S-Video
out as well as a RCA video out. A nice
touch I thought.

Even with the S-Video port removed
from my BookEndz I still experience a
bit of wrangling to get my TiBook con-
nected. My best guess is that the RJ-11
(modem) connector is the culprit, but I
might need that. I've figured out that if I
start to slide my TiBook in, and then lift
the front about 30° up, it'll lock togeth-
er just right. A bit frustrating, I'll admit,
but it was quick to figure out, and the

support web site even suggests this.

Removing my TiBook is much easier.
Unlike previous models of BookEndz,
but standard on PC docking stations,
there are two ejector handles. When my
PowerBook is docked, they swing back,
and to eject I just pull them forward
while pressing back against two thumb
rests. My PowerBook slides out without
a problem. And because I'm paranoid
about someone walking off with my
PowerBook I can still use my Kensing-
ton security cable. When the cable isn’t
connected to my PowerBook it easily
locks into a provided port on the back
of my BookEndz. If I was really paranoid
I guess I'd lock down both the BookEn-

dz and the PowerBook.
Aside from the minor
hassle to dock my laptop,
the only other issues I
have with the BookEndz
are features that they could
have added, but didn’t. With
the issues people have with
heat and TiBooks I would have
thought a fan in the BookEndz
would have been a great addi-
tion. And while one FireWire port
on my TiBook
is more than
enough
when I'm
in portable
mode, how
hard would it have
been to include a second port
with a built-in FireWire hub?

The docking issues are mostly out of
the hands of the BookEndz developers,
and the two additions I'd like to see
added are more wish-list items. With
that said the BookEndz does what it
advertises. When I arrive at my desk in
the morning I dock my TiBook and I'm
ready to go. I don’t have to connect my
USB keyboard, my FireWire drive, my
Ethernet cable, or my external video. Is
it worth the $250 you’ll spend for one?
Maybe not. But if you can afford it, go
for it.

Manufacturer: Photo Control Corp.

Web Site: http:/www.bookendzdocks.com/
bookendz/index htm

Requirement: Any model Titanium
PowerBook
Reviewer’s Rating: 3 Peaches
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' Atlanta Membership Application
Macintosh Atlanta Macintosh Users Group
Users Grou p P.O. Box 15130, Atlanta, GA 30333-0130

To join, fill out and print this page, attach your check (or fill in the required credit card information), and
mail to the address shown above. Membership fees are non-refundable (if for some strange reason you
choose to cancel your membership).

Membership Category: CdJoin AMUG [CJRenew my membership

[l keguiar mempersnip »4U per year.
Membership Benefits: Admission to General Meetings; 1-year Maclanta Newsletter Subscription filled
with tips, tricks and reviews; special “Members-only” discounts on hardware and software; one account
with full member access to the AMUG Online Community.

[0 Household Membership $10 per year.
Requires one household member to hold Regular Membership. Additional Household Members may
join for $10 each. Membership benefits are the same as a Regular Member, except only one Newsletter
will be mailed per address. Those under 18 will require written parental permission before receiving
an Online Community Account.

O Student Membership $25 per year.
Copy of student I.D. and current class registration required for this level of membership. Membership
benefits are the same as a Regular Membership.

[0 Corporate Membership $105 per year.
Includes 3 memberships. Additional members may be added at $35 each. Corporate membership ben-
efits include: Admission to General Meetings; 1-year Maclanta Newsletter Subscription filled with tips,
tricks and reviews; special “Members-only” discounts on hardware and software; three accounts with
full member access to the AMUG Online Community.

Name Company Name (if Corporate Membership)
Address ' Occupation

City, State, Zip Code Date of Birth (optional)

Home Phone Work Phone E-mail Address

Computer Make/Model (most commonly used if more than one) Internet Service Provider (ISP)?

OMembership  OProgram O Web Site
Amount of RAM? Mac OS Version? ONewsletter OPublicity O Online Community
OEducation OTreasurer [ Secretary

Type of Internet Connection (Dial-up, DSL, Cable Modem)? Please check the area(s) in which you would like

Please Note Method of Payment: to assist AMUG.

[0 Check (made payable to AMUG)
O Please charge my Visa/Mastercard/Discover/AMEX How did you hear about AMUG?

Cardholder Name (as it appears on Credit Card) Cardholder Signature

Credit Card Number Expiration Date
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* Troubleshooting and
configuration issues

v
® Purchasing and m a CI ntUSh
system integration S u p p 0 rt
® Customized project r.)
development using H ea d aChes .
FileMaker Pro,

AppleScript,
and WebObjects

AMUG members who mention this ad
will receive a special “try & buy” rate:
only $200 for the first 4 hours of
service. (A savings of $180). Call
360Works at 770-234-9293.

g Appl o
ohien @ ¥ 770-234-9293

Experts W Fletlaker 3 www.360works.com
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AMUG meets every 3rd Tuesda
of the month at Macquarium (1800
Peachtree Street NW, Suite 250;
404-554-4000).

Meetings start at 7 pm and
consist of a 30-minute Q & A ses-
sion followed by a major presenter
and then a raffle for free software,
hardware, and stuff.

Go to http://www.amugonline.org/meetings/ for detailed
driving directions.

ATIANTA MACINTOSH USERS GROUP
PO Box 15130
Arianta, GA 30333-0130


http://www.amugonline.org/meetings/

